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° Disabling the Design Kit Software

About Design Kit Installation and Setup

Advanced Design System (ADS) from Agilent Technologies is a tool used by engineers for a variety of design
applications, such as RFIC, System, MMIC, Hybrid or Board level design. In order to effectively use the design
environment and to take advantage of its powerful simulation capabilities, designers must have a library of
components that are linked to model files or simulation data.

For RFIC designers, the components and models are typically distributed by a foundry in the form of a design kit. A
unique design kit is created for each process and each CAD tool. This kit is given to the foundry customer to use when
designing their circuit.

To help RFIC designers become more successful with our electronic design automation (EDA) software, Agilent
Technologies has been working with popular foundries to provide ADS components and translated model files for
distribution by the foundry to the IC designer. Many customers are also creating design kits themselves.

Design kits in ADS are not beneficial only to RFIC designers. This library structure can be used for any technology or
process to package and distribute a reusable set of components. With the information provided in this document, you
can now easily install and manage all of your ADS Design Kits.

The intent of this manual is to provide instructions for unzipping, installing and setting up ADS Design Kits that will be
used in your designs.

The ADS Design Kit Infrastructure has been developed and tested to provide you with a standard method for building,
testing, installing and using ADS Design Kits within Advanced Design System. If you are interested in developing your
own ADS Design Kit, refer to the ADS Design Kit Development documentation. You can also test your model file
performance relative to other models using the ADS Design Kit Model Verification Toolkit. For more information on the
verification toolkit, refer to the ADS Design Kit Model Verification documentation.

The content of this document addresses the installation and configuration of ADS Design Kits for ADS Front End and
Front to Back design flows. For more information, refer to ADS Design Flows.

ADS Design Flows

Advanced Design System is a flexible tool that can be used on its own or in conjunction with other CAE tools in a
variety of design flows. An engineer using the ADS Front to Back design flow enters a design in the ADS schematic
editor and uses the ADS simulator for analysis. The layout is created in ADS by automatically generating it from the
schematic or by manually creating the layout, or a combination of the two processes. Export tools are provided to
transfer the layout to third party manufacturing tools.
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The RF Design Environment (RFDE) for Cadence provides a tightly integrated EDA solution that enables
RF/mixed-signal IC designers to simulate their designs directly in the Cadence environment using the ADSsim RF
simulator. This enables the RF/MS IC customer to take advantage of complementary features provided by both Agilent
Technologies and Cadence Design Systems. For more information on RFDE, refer to the Agilent EEsof EDA Home Page

at http://eesof.tm.agilent.com/

An engineer using the ADS Front End design flow enters a design in the ADS schematic editor and uses the ADS
simulator for analysis. The design is then re-entered in a separate layout tool. To validate the integrity of the layout,
the ADS Netlist Exporter is used to create a netlist for layout vs. schematic comparison. For more information on Front
End Design Flow, refer to the ADS Netlist Exporter documentation.

An engineer using the RFIC Dynamic Link Flow enters a design in Cadence Virtuoso Schematic Capture. The design is
then dynamically linked via inter-process communication (IPC) for simulation in ADS. For more information on the
RFIC Dynamic Link Flow, refer to Design Kit Development for RFDE and RFIC Dynamic Link in the ADS Design Kit
Development documentation.

Minimum Requirements

The minimum requirement for using the design kit tools described in this document is Advanced Design System 2001
or later.

ADS Design Kit development has progressed to provide standards that enable ease of installation and use in Advanced
Design System. If you have an old design kit that you would like to modify to function with the new ADS design kit
tools, refer to the ADS Design Kit Development documentation. If you are not comfortable creating or modifying your
own ADS Design Kits, contact Agilent EEsof EDA's Solution Services department or consult your Agilent Technologies
representative.

Previous Versions of Design Kit Tools

Prior to ADS 2001, the Solution Services organization at Agilent EEsof EDA supplied a preliminary version of design kit
software. This preliminary version of software was intended for use with design kits that they had created. To enable
this software, the user was required to modify some configuration variables. It is assumed that the majority of ADS
design kit users do not have any previous versions of the ADS design kit tools. However, if you have two design kit
menus in the ADS Main window, or only have an old design kit menu displayed, you will need to make some
modifications to your existing configuration to use the new tools effectively. While you will not need to add anything to
any of your local files, you will need to either delete or comment out any old design kit configuration information to
avoid conflicts with the new software.

! Caution
All of the code shipped with Advanced Design System contains the files required for the new ADS design kit
tools installed under $HPEESOF_DIR. If your ADS installation still contains an older design kit configuration,
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there may be conflicts and your configuration information could be overwritten.

For more information on design kit configuration and menus, refer to Setting Up Design Kit Software and Menus.

ADS Design Kit Tools Overview

Getting started is a simple process, as shown in the following figure ADS Design Kit Process.

-
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i

List/review your design kit status
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:
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l

[:/ Start using your new ADS Design Kit

N

./

N

S

ADS Design Kit Process

While several steps shown in ADS Design Kit Process are listed as optional, it is recommended that you familiarize
yourself with all of the capabilities of the tool to maximize your experience. For detailed information on using the ADS

design kit tools, refer to Using the ADS Design Kit Tools.
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Design Kit Customer Support

If you encounter problems installing or using a design kit that was obtained from a foundry or other distributor, you
should first contact the design kit distributor. If the design kit developer determines that the problem is not with the
design kit, they can forward the design kit to the Agilent EEsof EDA customer support department and work with
Agilent Technologies to determine the problem. Please do not contact the Agilent EEsof EDA customer support
department directly to report a problem with a design kit. This is because Agilent Technologies will not have access to

the design kit unless it comes directly from the distributor.

Using the ADS Design Kit Tools

This topic describes how to use the various tools provided in the DesignKit pull-down menu. The ADS DesignKit menu

appears in your ADS Main window when you launch Advanced Design System.

.

& Advanced Design System 2008 (Main)
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File ‘iew Tools
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File Browser
[=} = defaultdrzo0
t. .
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23 unkitled_prij
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Ise the File menu or the File Browser ko open a project

—_

If you have a design kit menu item available, but it is different than the one shown above, refer to Previous Versions

of Design Kit Toals.
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Where to Install a Design Kit

A design kit is a self contained library. It is a set of directories and files in a standard format. To support large
companies with complex systems of CAD tools and design kits from many different vendors, as well as individual
engineers on stand-alone systems, a design kit that is to be used in ADS can be installed anywhere on your system. It
does not have to be connected to the ADS software installation. If your company does not already have a specified
location to store design kits, it is recommended that a directory be created to hold all design kits in one location.

Understanding the 'ads.lib' File

Before using the design kit tools, some users, especially CAD managers, may find it helpful to understand the function
of the ads.lib file. If you are not interested at this time, you can skip this section and proceed to Install ADS Design
Kit.

The ads.lib file is a design kit control file that tells Advanced Design System which design kits to install. A template of
this file is included in the design_kit subdirectory of the design kit directory structure.

When a design kit is installed, a copy of the records line of the template file is made and stored outside of the design
kit at a specific LEVEL. The location (LEVEL) of the file controls who has access to the design kit when ADS is started,
as described below.

The format for the records line of the ads.lib template file is a single line with 4 fields, separated by vertical bars.
kitname | path to design kit | path to kit boot file | kit version

The following table provides a description for each of the fields shown.

The ads.lib Fields

kitname The name of the design kit.
path to design kit The installation path to the currently installed design kit.
path to boot file The absolute or relative path to the boot file. If the path

is relative, it is relative to the second field, path to
design kit. Not all design kits have a boot file, so this
field is optional.

kit version This is a string used to identify the design kit version.

While it is not necessary for design kit use, you may find it helpful to understand certain characters used in the ads.lib
file to specify comments and to disable a design kit.
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e To insert a comment into the template ads.lib file, begin the line with a pound sign (#).
e To disable a design kit, begin the line with an exclamation point (!). The design kit will not be loaded by ADS, but
the design kit setup dialog will still recognize it.

Ultimately, ads.lib files can exist in any of the locations listed in the following table. Note that each of these locations
is referred to as a LEVEL in the ADS Design Kit user interface.

The ads.lib File Locations

Level Directory Description

SITE LEVEL $HPEESOF_DIR/custom/design_kit An ads.lib file in this location on a
networked system lists all the design
kits that are available for all users.
Note that the SITE LEVEL directory
can be changed by setting the
configuration variable
DESIGN_KIT_SITE_PATH in
design_kit.cfg. For more information,
refer to SITE LEVEL and the table

ADS Design Kit Variables.

USER LEVEL $HOME/hpeesof/design_kit An ads.lib file in this location lists
design kits that only the user has
access to.

STARTUP LEVEL Startup directory An ads.lib file in this location lists

design kits that will only be available
if ADS is started in this directory.

PROJECT LEVEL Project directory An ads.lib file in this location is read
when the project is opened. Any
design kits listed in it will be made
available for designs in the project.

With this capability, a user in a networked environment can have access to a specific design kit without exposing all
engineers to it or without requiring the assistance of an administrator with root permissions to install it. Another
benefit is that a site librarian can manage a set of libraries that are accessible to all engineers without any effort from
the engineers. These are some typical ways that a system is configured.

Another way to use this multi-layered functionality is for an end user to have a set of ads.lib files in different
directories that refer to different processes. By starting ADS in the proper directory, the related design kits will be
loaded for that session. An advanced CAD manager may even choose to set up a system of scripts that controls the
ads.lib files for the end user to further tailor the environment on the fly for a specific manufacturing process.

 Note

To start ADS from a specific directory on unix, cd to that directory. On a PC, multiple shortcuts can be created
and the shortcut property Start in can be set to different startup directories.
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The SITE LEVEL is disabled by default so that a user in a networked system that supports a large number of design
kits will not get all of the available design kits loaded when he or she starts ADS. However, the user can see the
available design kits even when the level is disabled. To selectively enable a smaller number of those kits, use the
Copy and Paste buttons in the design kit setup dialog to enable only the design kits needed at the USER LEVEL.

If, however, all users on the network will only ever use one design kit at a time, the SITE LEVEL can be enabled by the
CAD manager for all users by setting the DESIGN_KIT_LEVELS_ENABLED variable in
$HPEESOF_DIR/custom/config/design_kit.cfg. Enter this line: DESIGN_KIT_LEVELS_ENABLED=SITE:USER:STARTUP:
PROJECT or simply DESIGN_KIT_LEVELS_ENABLED=SITE if no user configurations are expected. The end user can
always enable other levels without disabling the SITE level. A copy of design_kit.cfg in $HOME/hpeesof/config will be
created and take precedence over those under $HPEESOF_DIR.

Note that if users have already been using the software and configuring design kits, they may have a local copy of
design_kit.cfg with this variable defined already. In that case, adding the variable in
$HPEESOF_DIR/custom/config/design_kit.cfg will have no effect. The variable must be modified at the user level, or
removed from the user level in order for the site level to be used.

The SITE LEVEL by default is under $HPEESOF_DIR, the installation location of ADS. On a PC network, $HPEESOF_DIR
might be on each individual machine. If this is the case, an alternate location can be specified as SITE LEVEL by
setting DESIGN_KIT_SITE_PATH in design_kit.cfg in $HPEESOF_DIR/custom/config. For more information, refer to the
table ADS Design Kit Variables.

The priority at startup is PROJECT LEVEL, STARTUP LEVEL, USER LEVEL and finally SITE LEVEL. If a design kit is listed
in more than one level, those specified in the USER LEVEL will have precedence over those under SITE LEVEL, and
those specified at STARTUP LEVEL will take precedence over those in the USER LEVEL. Additionally, each project
directory (PROJECT LEVEL) may have its own ads.lib file. This file will be read when a project is opened, and any
design kits specified in that file will be loaded. If a design kit by the same name is already open, it will be overwritten
with the new information. Closing a project to open a different project will not uninstall design kits opened in that
project since design kits cannot currently be uninstalled without restarting ADS.

Even though all design kits are intended to be able to coexist in ADS, there may be cases where this is not possible.
Some older design kits may not comply with the standard format. Additionally, ADS has a requirement that all
components have unique names in ADS, so nhames cannot be reused between design kits. If these types of problems
are encountered, they can usually be overcome by enabling and disabling design kits as needed through the user
interface or by manually editing ads.lib files and the design_kit.cfg file. Additionally, some custom AEL in older,
non-standard design kits may have problems co-existing with the current built-in design kit software.

To fully disable a design kit, you need to close ADS. Some parts of a design kit cannot currently be disabled
dynamically. Additionally, if design kit A is enabled in project Y and design kit B is enabled in project Z, closing project
Y to open project Z will not disable design kit A. Since a design kit enabled at the project level of a closed project will
not be visible in the setup dialog, open the list dialog to see a complete listing of all design kits that the system knows
about.

Install ADS Design Kit
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The Install ADS Design Kit dialog box enables you to unzip, define and install a new zipped ADS design kit.
To access the Install ADS Design Kit dialog box from the ADS Main window:
1. Choose DesignKit > Install Design Kits. The Install ADS Design Kit dialog box appears.

Idkug-3-1-02_v1.gif!

 Note

All paths displayed in the design kit user interface use the backward slashes ().

Unzip ADS Design Kit

Step one of the Install ADS Design Kit dialog enables you to unzip a new design kit. If your new design kit is currently
packaged in a .zip file, you will need to unzip the design kit in the appropriate location. If your design kit has already
been unpackaged, skip to Define a Design Kit. If your design kit has not been unpackaged and is not distributed as a
.zip file, refer to the installation instructions provided with the kit.

To unzip your new design kit:

1. Click Unzip Design Kit Now. The Unzip ADS Design Kit dialog box appears.

'az- Unzip ADS Design Kit e W

IUnzip File: \usersidefault| Browse, ..

To Directory: | Crusersidefaulk Browse.. .

2. To specify the path and file name of the file you want to unzip, click Browse next to the Unzip File field. The
Unzip From File Browse dialog box appears.

11
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Unzip From File Browse

Look, in: Ilal defaultd j L] IfF *
- IChhpeesaf
J-.—J IChstudio_Files
Recent IChverify_pri
Desktop

by Documentz

ty Computer

My Metwork.  File name: I j Open I
Places
Filez of type: I“_zip j Cancel |

3. Double-click as needed to locate the directory containing your zipped file in the Directories field, then click the
appropriate file in the Files field. Alternatively, you can enter the full path and file name in the Selection field.

4. After selecting the file you want to unzip, click OK. You are returned to the Unzip ADS Design Kit dialog box.

5. To specify the new location for the files you want to unzip, click Browse next to the To Directory field. The Unzip

To Directory Browse dialog box appears.
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( & Unzip To Directory Browse E ]

Look in: I Ciusersidefaults M a @ ﬂ _,..? |E] E]

».: y My Compukter

Iy studio_File
__._J sarpalan |5y weriFy_pri

Files of bype: | Directories

6. Double-click as needed to locate the directory where you want your unzipped files to be located in the Directories
field. Alternatively, you can enter the full path in the Selection field. If you are unsure of where to unzip your
design kit, refer to Where to Install a Design Kit.

7. After selecting the directory in which to unzip your files, click OK. You are returned to the Unzip ADS Design Kit
dialog box.

8. Click OK to unzip your design kit. An Information Message dialog reporting that the design kit was successfully
unzipped appears after the unzip operation is complete.

A new directory containing your design kit is created in the location that was specified in the To Directory field of the
Unzip ADS Design Kit dialog box. This new directory contains several subdirectories, typically including:

circuit
design_kit
e doc
examples

Depending on your design kit, there may be additional subdirectories beyond those listed above. For detailed
information on the contents of design kit directories, refer to the ADS Design Kit Development documentation.

Define a Design Kit

13
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Step two of the Install ADS Design Kit dialog box enables you to view the design kit definition or define a new design
kit. After the process in Unzip ADS Design Kit is complete, the Install ADS Design Kit dialog box is automatically
updated with the design kit definition information. Since this information is defined by the vendor as part of the design
kit, it should not be changed by the user or a CAD manager handling a SITE installation. Modifying this information
may cause the design kit to be non-functional.

'a:- Install ADS Design Kit e i‘:ﬂ

1. Unzip Design Kit
This skep may be skipped if the Design Kit is already unzipped.

[Llnzip Design kit Mow, .. ]

2, Define Design Kik

Enter full Path to the directory of the desired Design Kik,
If available, the remaining info will be automatically filled in.

Path

1 {DKD Demakit_yz]
Marne

Demakit_v2

Book: File (optional)
=

Version
2.0

3, Install Desian kit

Select Installation Lewvel @ |1JSER LEVYEL M

If your design kit was not distributed as a .zip file or was already unzipped, proceed to the next section.

Path and Name
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To specify the path and name of the design kit you want to install:

1. Click Browse next to the Path field in the Install ADS Design Kit dialog box. The Select Design Kit Directory dialog
box appears.

i 'Select DesigniKit’ Directory e W

Look in: ) C:\DKD\Demakit_v2 Qe © Q @[ E

My Computer

| sarpalan I design_kit
I dac
I dre

I examples
I werification

Directory:

Files of type: |Direckories Zancel

2. Double-click as needed to locate the directory containing your design kit in the Directories field. Alternatively,
you can enter the full path in the Selection field.

3. After selecting the design kit directory, click OK. You are returned to the Install ADS Design Kit dialog box. The
Path, Name, Boot File and Versions fields should now contain all data needed for the design kit to be installed.

) Note

If the design kit being installed conforms to the ADS standard, it should have a name in the Name field. For
some design kits created before ADS 2001, the Name field may not be filled in automatically and must be
manually entered. If this is the case, there should be a README or installation file that contains the design kit
name. Specify that name in the Name field.

Boot File (optional)

The Boot File is an optional file defined by the design kit developer and may contain either the absolute path and file
name or a relative path and file name of the boot file for the design kit to be installed. A relative path is relative to the
top level of the design kit. To specify an alternative boot file:

1. Click Browse next to the Boot File field in the Install ADS Design Kit dialog box. The Select Design Kit Boot File

15
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dialog box appears.

Select DesignKit Boot File E P,:ﬂ
Loak in: | 1= ael j ¥ ER-
= bioot, zel
,—J bioot, atf
Recent calbacks. ael
callbacks, atf
@ rmenu. ael
renu. akf
Desktop palette. ael
palette, atf

\$

by Documents

@

ty Computer

|

My Metwork File name: || ﬂ Open |
Places
Filez of type: HE j Cancel

2. Double-click as needed to locate the directory containing the boot file for your design kit in the Directories field,
then click the appropriate file in the Files field. Alternatively, you can enter the full path and file name in the
Selection field. The boot file is typically located in the de/ael subdirectory of the design kit.

3. After selecting the boot file you want to use, click OK. You are returned to the Install ADS Design Kit dialog box.
The Boot File field should now contain the absolute path and file name or relative path and file name of the new
boot file for the design kit to be installed.

Version

The Version field should contain the version humber for the design kit to be installed. This number is typically defined
by the design kit developer and is used for tracking the design kit version for support. This field should remain as the
vendor has set it and should not be modified.

If the version number was not defined, you may see an N A in this field. You could specify or change the version
number by entering a new number in the Version field; however, this is not recommended.

© Note

The version data can be any string of characters with the exception of the vertical bar.
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Install Design Kit

Since a design kit can reside anywhere on your file system, for ADS to find it, it must be registered in a recognized file
(ads.lib) in a standard location. This file (ads.lib) can reside in one of four locations referred to as a LEVEL. Step three
of the Install ADS Design Kit dialog box enables you to specify the LEVEL at which to register or install the design kit.

For more information on the ads.lib file, refer to Understanding the 'ads.lib' File.

The different levels displayed in the Select Installation Level drop-down menu depends on your write permissions at
these levels. If you do not have write permission at the SITE LEVEL, you will not be able to select that option.
The levels can be:

e SITE LEVEL - Used to provide design kit capability for users in a networked environment.

e USER LEVEL - Used to provide design kit capability for an individual user so you can manage your own design
kits.

e STARTUP LEVEL - Used to help you manage multiple design kits at different locations.

e PROJECT LEVEL - Used to manage design kits within an ADS project.

To select a level for your design kit:

1. Use the Select Installation Level drop-down menu to select an appropriate level for your design kit.

2. After selecting a level, click OK in the Install ADS Design Kit dialog to install and enable the design kit. An
Information Message dialog stating that the design kit was successfully enabled appears.

3. Click OK to clear the Information Message dialog. Your design kit is now ready for use. However, it is
recommended that you continue to Setup ADS Design Kits to learn how to use the setup tool for managing
installed design kits. Also review the section Setup Project Technology Files to learn how to configure a project to
use technology files (layers, preference and Momentum substrate files) from an enabled design kit.

© Note

If an ADS Project is open, enabling a design kit will close all open designs and schematic and layout windows.

To get started using your design Kkit, refer to Using an ADS Design Kit to Create a Schematic.

Setup ADS Design Kits

The Setup ADS Design Kits dialog box enables you to view or modify the installation status of each of the different
levels and design kits available. Note that some changes made in this dialog may only be effective after ADS is
re-started.

To access the Setup ADS Design Kits dialog box:

1. Choose DesignKit > Setup Design Kits. The ADS Design Kit Setup dialog box appears.
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Design Kits can be installed at four different levels from this dialog. The levels available depends on your write
permission for each of these levels. The available levels are:

e SITE LEVEL

e USER LEVEL

e STARTUP LEVEL

e PROJECT LEVEL

2. By selecting one of the levels in the Setup ADS Design Kits dialog box, you can:

e View the properties of a selected level - Note that as you click a level listed in the Overview section of the
dialog, the Level Information in the View/Modify Properties section changes accordingly.

e Enable or disable a selected level - You can click a level listed in the Overview section of the dialog and then
click the Disable Level button below the Overview section. Note that the traffic light indicator next to the
level you selected turns to yellow to indicate that the level is disabled. The Disable Level button toggles to
Enable Level and can be clicked again to enable the level. When a level is disabled, the ads.lib file at that

18



Advanced Design System 2008

level will not be read the next time ADS is started, so design kits listed in that ads.lib file will not be
enabled for that session.

e Add a new design kit to the selected level - If you have the appropriate write permissions, you can click a
level listed in the Overview section of the dialog and then use the Design Kit Information section of the
dialog box to define the design kit properties. For more information on setting up the design kit properties,
refer to Define a Design Kit. Once the properties are set up, click Add Design Kit to Level.

3. By selecting one of the design kit names under a level in the Setup ADS Design Kits dialog box, you can:

¢ View the properties of the selected design kit - Once you click a design kit in the Overview section of the
dialog box, the design kit properties are displayed in the Design Kit Information section of the dialog.

e Update the properties of the selected design kit - If you have the appropriate write permissions, you can
use the Design Kit Information section of the dialog box to update the properties of a selected design kit.
For more information on the design kit properties, refer to Define a Design Kit.

e Enable or disable the selected design kit - After clicking a design kit in the Overview section of the dialog
box, you can click the Disable Design Kit button just below the Overview section. Note that the traffic light
indicator next to the design kit you selected turns to yellow to indicate that the design kit is disabled. The
Disable Design Kit button toggles to Enable Design Kit and can be clicked again to re-enable the design kit.
A disabled design kit will not be completely cleared until the ADS session is exited. The traffic lights in the
Overview section indicate the status of levels and design kits where green indicates enabled, yellow
indicates disabled, and red indicates that there is an error or incorrect design kit properties.

© Note

A design kit will only be properly installed and available for use if both the level and the design kit are enabled.

e Copy or cut the selected design kit - After clicking a design kit in the Overview section of the dialog box,
you can click the Cut or Copy buttons to remove, move or copy a design kit to a different level. After
cutting or copying a design kit, click another level and use the Paste button to place the design kit under a
different level.
4. Click Apply to apply the new settings or click the Reset button to undo all changes. You can also click Print to
print a hardcopy of the design kit setup to your local printer.

© Note

If an asterisk ‘7 is displayed next to the level or design kit in the Overview section of the Setup ADS Design
Kits dialog box, the settings in the current ADS session do not correspond with the display settings. ADS may
need to be restarted for the settings to take effect. This is particularly true for disabling design kits since not
all parts of a design kit can be dynamically disabled in ADS.

5. Click OK to save all settings and exit the Setup ADS Design Kits dialog box.

SITE LEVEL

The SITE LEVEL setup option is used to provide design kit capability for users in a networked environment. This option
enables a site librarian or CAD manager to manage a set of libraries that are accessible to all engineers without any
effort from the individual engineers.

By default, the SITE LEVEL is disabled so that if it contains a large number of design kits, they won't be all loaded
when the end user starts ADS. The user should select only the design kits that he needs and use the copy and paste
buttons in the design kit setup dialog to enable them at his USER LEVEL.
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If all users at a site will only be using a single design kit, the SITE LEVEL can be enabled by the end user. It can be
also be enabled by the CAD manager by setting DESIGN_KIT_LEVELS_ENABLED=SITE in
$HPEESOF_DIR/custom/config/design_kit.cfg. Make sure this variable is not defined in
$HOME/hpeesof/config/design_kit.cfg in this case.

By default, the SITE LEVEL ads.lib file is stored in $HPEESOF_DIR/custom/design_kit. An ads.lib file in this location on
a networked system lists all the design kits that are available for all users. For more information on the ads.lib file,

refer to Understanding the 'ads.lib’ File.

On a PC network, $HPEESOF_DIR might be on each individual machine. If this is the case, an alternate location for a
master ads.lib file can be specified as SITE LEVEL by setting DESIGN_KIT_SITE_PATH in design_kit.cfg. For more
information, refer to ADS Design Kit Variables.

To view the SITE LEVEL information including ads.lib file location:

1. Choose DesignKit > Setup Design Kits. The ADS Design Kit Setup dialog box appears.
2. Click SITE LEVEL in the Overview section. This activates the Level Information section.

USER LEVEL

The USER LEVEL setup option is used to provide design kit capability for individuals working in a networked
environment. This option enables you to easily manage your own design kits without the help of a CAD manager.

In a networked environment, a user will not be able to selectively enable individual design kits at the SITE LEVEL. To
enable a subset of the design kits available at the SITE LEVEL, use the Copy and Paste buttons to copy each desired
design kit entry from the SITE LEVEL to the USER LEVEL. Then disable the SITE LEVEL and enable the USER LEVEL.

The ads.lib file is stored under $HOVE/ hpeesof / desi gn_ki t . An ads.lib file in this location lists design kits that only
the user has access to. For more information on the ads.lib file, refer to Understanding the 'ads.lib’ File.

To view the USER LEVEL information including ads.lib file location:

1. Choose DesignKit > Setup Design Kits. The ADS Design Kit Setup dialog box appears.
2. Click USER LEVEL in the Overview section. This activates the Level Information section.

STARTUP LEVEL

The STARTUP LEVEL is used to help you manage multiple design kits at different locations. You can start ADS from a
different directory, with a different shortcut on a PC, and by having a different ads.lib file in each possible startup
directory, you can control which design kits are installed for each session of ADS.
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The ads.lib file is stored under the designated startup directory. An ads.lib file in this location lists design kits that will

only be available if ADS is started in this directory. For more information on the ads.lib file, refer to Understanding the
'ads.lib' File.

To view the STARTUP LEVEL information including ads.lib file location:

1. Choose DesignKit > Setup Design Kits. The ADS Design Kit Setup dialog box appears.
2. Click STARTUP LEVEL in the Overview section. This activates the Level Information section.

© Note

To configure a second STARTUP design kit configuration, restart ADS in that directory and then define the
design kit configuration.

PROJECT LEVEL

The PROJECT LEVEL is used to manage design kits within an ADS project.

The ads.lib file is stored under a designated project directory. An ads.lib file in this location is read when the project is
opened. Any design kits listed in it will be made available for designs in the project. For more information on the

ads.lib file, refer to Understanding the 'ads.lib' File. At this time, PROJECT LEVEL design kits are not disabled when the
project is closed. ADS must be restarted to disable a design kit.

To view the PROJECT LEVEL information including ads.lib file location:

1. Choose DesignKit > Setup Design Kit. The ADS Design Kit Setup dialog box appears.
2. Click PROJECT LEVEL in the Overview section. This activates the Level Information section.

List ADS Design Kits

The List ADS Design Kits dialog box enables you to view a list of all currently available design kits and their status.

To view your design kits from the ADS Main window:

1. Choose DesignKit > List Design Kits. The List ADS Design Kits dialog box appears. Note that the initial list is a
brief list showing only the design kit nhame, version and status.
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'aa- List ADS Design Kits | r‘:ﬂ
Currently installed Design Kits
[] wiew details
Marmne Wersion Status
Demokit_vz 1.1 enahbled
ABC_Design_kit z.0 enabled

Enable Selected Design Kik Save ko File, .

2. Click the View Details checkbox to view the details for each installed kit. A scroll bar appears enabling you to
scroll through the items in the expanded list.

Currently Installed Design Kits

The Currently Installed Design Kits section of the List ADS Design Kits dialog box provides specific information related

to each of your design kits. The following table provides a description of each of the items listed in this section. You
can use the slide-bar to view the details of each design kit.

List ADS Design Kit Overview

Name The design kit name is a unique identifier that enables

you to load and use multiple design kits during a single
session.

Version The version number is very important for tracking and

troubleshooting purposes.The version number enables
Agilent EEsof EDA Customer Support to identify and
install the same version to help solve technical problems.
Status The load status field indicates the current state of a
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design kit.

Path The path field indicates the current directory location of
the specified design kit.

Boot File The absolute path and file name or relative path and file
name of the boot file.

Load Level The Load Level field is used to display the installation
LEVEL used to determine who will have access to the
design kit. The field also includes the project name for
design kits enables at the project level.

Level File The level file field displays the path and file name for the
ads.lib file used.

Changing Dialog Box Dimensions

You can use your cursor to manipulate some of the physical characteristics of the List ADS Design Kits dialog box. Try
changing the width of each column in the Currently installed Design Kits section of the List ADS Design Kit dialog box
by dragging the borders between the titles at the top of each column.

You can also use your cursor to expand the over-all size of the dialog box to reduce the need for scrolling through the
Currently installed Design Kits section. Try grabbing the edge of the dialog box to expand it now. If you later want to
save space on your desktop, you can grab the edge of the dialog box again and return the dialog to it's original size.

Enable Selected Design Kit

Design Kits that have been installed are kits that are recognized by Advanced Design System. A design kit that is
recognized by ADS can be either enabled or disabled. If a design kit is enabled, it means that you can access and use
the components. If a design kit is disabled, it is not available for use because:

e The Design Kit was not installed.

e The Design Kit was overloaded (more than one design kit with the same name is enabled, possibly at different
levels).

e There was an error during the enabling process.

To enable a design kit that is currently disabled:

1. Click the disabled design kit that you want to enable in the Currently installed Design Kits section of the List ADS
Design Kits dialog box. The Enable Selected Design Kit button is activated.
2. Click Enable Selected Design Kit in the List ADS Design Kits dialog box.

© Note
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If an ADS Project is open, enabling a design kit will close all open schematic and layout windows.

3. An information message dialog stating that the design kit was enabled in the current ADS session appears. A
second message in the dialog appears asking if you want to enable the design kit by default at ADS startup.
Choose yes to enable the design kit.

Save to File

You can save a list of the currently installed design kits to an ASCII text file in a specified location from the List ADS
Design Kits dialog box.

To save the list of design kits and their current status,

1. Click the Save to File button. The Save Status As dialog box appears.

2. Double-click as needed to locate the directory to store your list of design kits in the Directories field.

Alternatively, you can enter the full path in the Selection field.

Add the name of the file to the path in the Selection field.

4. After selecting the directory path and file name, click OK. You are returned to the List ADS Design Kit dialog box.
An ASCII text (.txt) file is created in the location specified. The file contains the information related to each
specific design kit in the Currently installed Design Kits displayed in the List ADS Design Kits dialog box.

w

Example list of design kits

Design Kits Levels

Level : SITE
File location: $HPEESCOF DI R/ custonm design _kit/ads.lib
Defaul t: enabl ed
Level : USER
File |l ocation: $HOVE hpeesof/design kit/ads.lib
Def aul t: enabl ed
Level : STARTUP
File location: $HOVE ads.lib
Def aul t: enabl ed
Level : PRQIECT
File location: NA
Def aul t: enabl ed

Design Kits

Design Kit: DenoKit_V2
Pat h: $HOVE/ DKDY DenoKi t _V2
Boot file: del/ael/boot
Version: 1.1
Load | evel : USER
Def aul t: enabl ed
Status: enabl ed
Design Kit: ABC Design_Kit
Pat h: $HOVE/ dk/ f oundr yKi t s/ abc_desi gn_ki t/
Boot file: de/ael/boot
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Version: 2.0

Load | evel : USER
Def aul t: di sabl ed
Status: di sabl ed

Print

You can print a list of the currently installed design kits to a local printer from the List ADS Design Kits dialog box.
To print the list of design kits and their current status,

1. Click the *Print*button.

Setup Project Technology Files

The Setup Project Technology Files dialog box enables you to configure a project to use technology files from a specific
design kit. The technology files which may be provided are layers files, preferences files and Momentum substrate
files.

You can create a new project with the default technology as a design kit's technology, this can be set up from the ADS
New Project dialog box and only needs to be done when the project is created and the design kit has already been
installed. If you have a number of design kits enabled, you can only choose one default technology for your project at
project creation. However, using the ADS New Design dialog box, you can set your design to use a different design
kit's technology. This can be different from the one selected at project creation.

If your design kit's technology files, or any of your other technology sources, have been updated after you have
created your new project (or design) with that technology, then you can select DesignKit > Setup Project from the
ADS Main window to explicitly instruct the software to overwrite your existing project technology files with your
updated technology source files. You can also use the Setup Project menu item to set a different technology as your
default for the current project or you can copy in a new set of technology files from a new source to your project that
can be used by any new designs in that project.

Most files in a design kit are accessed directly from the design kit. However, these technology files include user

editable attributes, so they are copied in the project. Appropriate path variables are modified so that they will always
be read from the project directory.

Before continuing with this section, you must have already installed and enabled the design kit that will be used as the

source for technology files for this project. It can be enabled at any level. Refer to Install ADS Design Kit or Setup ADS
Design Kits for instructions.
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To select the Design Kit technology files for a project:

1. Choose DesignKit > Setup Project. The Setup Project Technology Files dialog box appears. You must have a
project open for this menu pick to be available.

2. From the list of available technologies, select the design kit from which to copy the technology files. If there are
no design kit technologies enabled, the only options in the list will be ADS Standards and Custom technology
directory sources. Click the Cancel button and enable a design kit before proceeding if you want to setup your
project with a design kit's technology.

'E:i efup Project’ lechnology Files m@

This dialog allows setup of project technalogy files,

Setup Project Technology Files:

Design kit Demokit_We ™| | Wiew Details, .

Set as default For all new designs in project.

o] [ow]

3. Once you have selected a design kit technology or other technology, click the View Details button. The
Technology File Integration Details are updated accordingly to inform you of the action that will take place if you
click OK in the Setup Project Technology Files dialog box. After you understand the details, click OK in the
Technology File Integration Details dialog box to clear the dialog.

4. Use the Set as default for all new designs in project checkbox in the Setup Project Technology Files dialog box to
set the selected technology as your new project's default technology for all new designs created. The check box
is enabled by default.

e The layers file for layout is the most important file to get from the design kit. Preferences files are typically
not as important as the layers file. Momentum substrate files are necessary only if you intend to use
Momentum. Additionally, an advanced user may understand how to browse to find a Momentum substrate
file from the design kit without copying it into the project. If a substrate file is opened from the design kit
directory, be careful not to modify it.

o If there are no technology files supplied with the design kit, the view details will show the default layers and
preferences files being used for the project instead. The default preference files will already have been
copied into the project when it was created. Default layers files are opened from
$HPEESOF_DIR/de/defaults until a change has been made to any layer attributes. Then a copy is saved in
the project directory and read from there.

 Note

If you have saved layers or preference files with a custom name in your project, this process will not touch
those files. Any designs that reference those custom files will continue to reference them. If you wish to have
those design files start to use the new files from the design kit, you must use the Read button from the layer
dialog or preferences dialog to reset the file name to the default names.

5. After indicating which technology source will be used, click OK to initiate the copying procedure.

6. If the files do not currently exist in your project then they will be copied in. If files already exist, you are asked if
you want to overwrite the existing files. In all cases, existing files by the same name will be renamed. No files
will be deleted by this procedure.
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Using an ADS Design Kit to Create a Schematic

After successfully installing an ADS design kit and learning how to use the Design Kit Toolset to manage your design
kits in ADS, you can use this section to help you get started designing a circuit with an installed design kit.

If the design kit that you installed came with directions, review these before starting to design. The design kit may
contain special features not covered in this documentation that might require manual configuration. There may also be
custom menus that you should be aware of.

A design kit from a foundry should also contain detailed information regarding each component in the design kit, as
well as an example project demonstrating how the design kit may be used. This example can be opened and
simulated to ensure that you have properly installed the design kit.

Components in a design kit may be presented in the component palette or in the library browser, or both. Both are
accessed from the schematic window. The component palette is always visible on the left side of the drawing area. If
your selected design kit is not visible in the palette, open the Component Palette List and scroll down until you find it.
A single design kit may include more than one palette. For example, passive and active devices might be listed in
separate palettes. Likewise, components in the library browser can be presented in different sub-groups. The library
browser can be opened by a button on the toolbar or from the Insert > Component > Component Library menu item.

il

One special component that will be in most design Kkits is a process or include component. In some cases, this is used
so the simulator can find model files stored in the design kit. If this component is supplied, it is most likely required to
be in your schematic for simulation to be successful. Find the process or include component on the palette or in the
library and place this component in your schematic first. Place it at the top level of a hierarchical design.

Continue designing your circuit now by placing components out of the design kit or the standard palettes. Place the
proper simulation components from a simulation palette, and simulate the circuit.

For an example project and example design kit to experiment with, browse to the examples directory and look for
DesignKit/bjt_dc_prj. For best results, make a local copy of the project before attempting to simulate, since simulation
requires write permission in the project directory, as do some design kit configuration steps. The design kit called
my_design_kit is included in a sub-directory of the project. An ads.lib file in the project directory ensures that the
design kit gets loaded when the project is opened.

For information on what to do if you have problems with a foundry-supplied design kit, refer to Design Kit Customer
Support.

Command Reference

This section describes the function of each menu selection provided in Advanced Design System (Main) DesignKit
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Menu.

DesignKit Menu

ADS Main window

Install Design Kits...

Unzip, define and install a new zipped ADS Design Kit. For more information, refer to Install ADS Design Kit.

Setup Design Kits...

View, modify or print the default installation status of each of the different levels and Design Kits available. For more
information, refer to Setup ADS Design Kits.

List Design Kits...

View, save to a file, or print a list of all currently available design kits and their status. For more information, refer to
List ADS Design Kits.

Setup Project...

Configure a project to use the technology files from a specific design kit. For more information, refer to Setup Project
Technology Files.

Setting Up Design Kit Software and Menus

This topic describes the details of configuration files and variables which are used to enable and disable the common
design kit software. This includes software for installing design kits, as well as the software to control the menus and
dialog boxes that are shipped with Advanced Design System for use with all design kits. This information is included

for advanced users or users of old design kits who experience problems between the new software and an old design
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kit.

Configuration Files

Each individual ADS tool has its own unique configuration file. These configuration files contain information required by
the software to install and enable the tools.

If you are an advanced design kit user, there are two configuration files that you should be aware of:

e The de_sim.cfg file. This is the general ADS configuration file.
e The design_kit.cfg file. This is the specific design kit configuration file.

The configuration files in ADS are read from four locations:

$HPEESOF_DIR/config This is the default location where configuration files are located when shipped with the
software.

$HPEESOF_DIR/custom/config This location is reserved for customization, typically by CAD managers.
$HOME/hpeesof/config This location can be used for customization by the end user. Configuration files in this
location may also be written to by the software.

./ Current working directory, either the directory where ADS was started or the current project directory.

If a variable is defined in more than one location, the last value read is the one that will be recognized by the system.

 Note

Any customization set up in $HPEESOF_DIR (software installation directory) should be confined to the custom
subdirectory. This is because anything outside of the custom subdirectory may be overwritten by a subsequent
update to the software.

The design_kit.cfg file is read in two different ways. It is read in conjunction with de_sim.cfg at ADS startup to add the
design kit user interface to ADS. Then when specific design kits get loaded or when the Design Kit Setup dialog is
used, the file is read directly to resolve other variables defined in the file.

The de_sim.cfg file is read from all four locations in the order listed above. The design_kit.cfg file is included by adding
the following line to the de_sim.cfg file:

+ design_kit

When + design_kit is encountered in a de_sim.cfg file, the design_kit.cfg file is only read from one location, as
opposed to the four locations described above. This single location is the same directory that contains the de_sim.cfg
file currently being read.
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This is the mechanism that is used to resolve the design kit variables that are used in other variables. First de_sim.cfg
includes design_kit.cfg to get the value of variables such as DESIGN_KIT_UI_AEL. Then de_sim.cfg includes de.cfg,
where a variable named PDE_AEL is set. PDE_AEL includes a reference to DESIGN_KIT_UI_AEL. This is how the user
interface and internal AEL code for the design kit infrastructure gets added to ADS. The variables DK_AEL_PATH,
DESIGN_KIT_UI_AEL, DESIGN_KIT_STARTUP_AEL and DESIGN_KIT_PROJECT_AEL are all used in this manner.

Additional design kit variables are used to manage the design kit setup or when individual design kits are enabled.
When such a variable is needed, the system reads the design_kit.cfg file from the three locations defined above.
Variables such as DESIGN_KIT_LEVELS_ENABLED, DESIGN_KIT_SITE_PATH and DESIGN_KIT_TECHNOLOGY_NAME
are resolved in this manner. Descriptions of how these variables are used is given in the table below.

Additionally, some other design kit variables are set in files such as hpeesofbrowser.cfg, hptolemy.cfg and
hpeesofsim.cfg. These variables extend certain paths so that the system can find files that are in a design kit. These
variables are described below as well.

Current Configuration Variables

The information described in the table ADS Design Kit Variables is a list of configuration variables used by the current
design kit infrastructure software beginning with ADS2001. This is the general code that installs and enables design
kits, as well as the user interface code such as menus and dialog boxes common to all design kits. This code should be
differentiated from any software or code that is specific to a particular design kit. Any code referred to in this section
is application extension language (AEL) code. For more information on AEL code, refer to the Advanced Design System
AEL documentation.

If you are a general user of new ADS design kits, it is not important to understand the information provided in this
section. This information is provided for CAD administrators, design kit developers or anyone who has worked with
design kits in ADS prior to ADS2001, when the design kit infrastructure code had to be manually configured. These
variables are now all set automatically in ADS.

Anyone who used design kits prior to ADS 2001 should check their de_sim.cfg files in all user configurable locations
and remove (or preferably comment out with a # sign in column one) any configuration variables used for general
design kit configuration in the past. The last section, Accessing Both Old and New Design Kit Menus Simultaneously,
will help you reset the necessary variables if you have an ongoing need for access to the old design kit software.

A description of each design kit variable required for current ADS design kit infrastructure software is provided in the
table ADS Design Kit Variables.

ADS Design Kit Variables

DK_AEL_PATH
This variable is set in the $HPEESOF_DIR/config/design_kit.cfg file. The DK_AEL_PATH variable is set to the
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directory where the common design kit AEL code resides. This variable is used by the next few variables in the file.
DK_AEL_PATH={$HPEESOF_DIR}/design_kit/ael

DKIT_ADSLIBCONFIG_PATH
When a design kit with encoded models is enabled, the following steps are taken by the design kit infrastructure to
ensure that the encoded models are automatically loaded when the simulator is run.

1. The <design kit>/circuit/config directory is searched for a file named ADSlibconfig.

2. The contents of the ADSlibconfig file are merged into the master file
$HOME/hpeesof/design_kit/circuit/config/ADSlibconfig.

3. In $HOME/hpeesof/config/hpeesofsim.cfg, DKIT_ADSLIBCONFIG_PATH is set to
$HOME/hpeesof/design_kit/circuit/config.

4. When the simulator is invoked, the variable ADSLIBCONFIG_PATH is read from
$HPEESOF_DIR/config/hpeesofsim.cfg. This path contains a reference to DKIT_ADSLIBCONFIG_PATH, so any
ADSlibconfig files in DKIT_ADSLIBCONFIG_PATH will be appended to ADSLIBCONFIG_PATH and used to find
encoded models during simulation.

The file $HOME/hpeesof/design_kit/circuit/config/ADSIlibconfig is managed by the design kit infrastructure and
should never be edited manually. Also, DKIT_ADSLIBCONFIG_PATH cannot be removed from
ADSLIBCONFIG_PATH. ADSLIBCONFIG_PATH can be defined in hpeesofsim.cfg in $HOME/hpeesof/config,
$HOME/hpeesof/custom/config or $HPEESOF_DIR/config.
DKIT_ADSLIBCONFIG_PATH=$HOME/hpeesof/design_kit/circuit/config

DESIGN_KIT_UI_AEL
This is the AEL code related to the Design Kit menu in the Main ADS window. It is read very early during boot-up.
DESIGN_KIT_UI_AEL={%DK_AEL_PATH}/dk_menu

DESIGN_KIT_STARTUP_AEL

This is a list of AEL files read later during boot-up. dk_startup contains code to load the specific design kits which
are currently configured. The other files contain code related to the common design kit menus and dialog boxes.
DESIGN_KIT_STARTUP_AEL={%DK_AEL_PATH}/dk_startup:{%DK_AEL_PATH?}/dk_explorer

DESIGN_KIT_PROJECT_AEL
This AEL file contains code that is invoked every time a user opens a project.
DESIGN_KIT_PROJECT_AEL={%DK_AEL_PATH?}/dk_project_attach

DESIGN_KIT_PROJECT_OPEN_AEL
This AEL file contains code that is invoked every time after a user opens a project.
DESIGN_KIT_PROJECT_OPEN_AEL={%DK_AEL_PATH}/dk_open_project_attach

DESIGN_KIT_LEVELS_ENABLED

This variable refers to the ads.lib files that will be read to load design kits. This is similar to the obsolete variable
DESIGN_KIT_LOCAL_OVERRIDE, but is less ambiguous and gives the user more flexibility and control. There is a
design kit menu pick that opens a dialog to control this variable.

To manually change it to suppress the reading of the ads.lib file at the specified level, remove the name of the level
from the list. Order of the list is not important and colons do not need to be retained. PROJECT:SITE is a valid value
instructing the system to read ads.lib from the current project and the site locations only. Locations are as follows:
SITE: $HPEESOF_DIR/custom/design_kit/ads.lib

USER: $HOME/hpeesof/design_kit/ads.lib

STARTUP: The directory from which ADS is invoked on unix. This can be set as a short-cut property for PC systems.
PROJECT: If the project level is enabled, the ads.lib file will be read if available any time a project is opened, and
design kits specified in that ads.lib file will be loaded. Note that leaving a project will not unload any design kits as
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the ADS system does not currently have the capability to remove the system components once they are loaded.
For more information on the ads.lib file, refer to the "Design Kit Development Guide".
DESIGN_KIT_LEVELS_ENABLED=USER:PROJECT

DESIGN_KIT_SITE_PATH

This variable is used to tell the system where to read the SITE LEVEL ads.lib file. The default value for this variable

is $HPEESOF_DIR/custom/design_kit/ads.lib. For a PC network, where ADS is installed directly on an end user's PC,
$HPEESOF_DIR is on that PC, not on the network like it is with a unix network installation. However, a CAD manager
might still want to maintain the master list of installed design kits (ads.lib) on a networked site. In that case, set

this variable to the network directory where the file is located. Define the variable in design_kit.cfg in
$HPEESOF_DIR/custom/config or $HOME/hpeesof/config.

DESIGN_KIT_SITE_PATH=F:\ADS_FILES

DESIGN_KIT_TECHNOLOGY_NAME (valid for ADS2002C only)

This variable indicates which design kit is to be used as the source for process technology files. If specified, the user
will be prompted to select layers and preferences and momentum substrate files to copy from this design kit. For
more information, see "Set the default design kit for new projects" in Setup ADS Design Kits.

This variable is set in the design_kit.cfg file. It can be defined at any LEVEL. If it is defined at the STARTUP level,
there may be multiple startup directories and each one can be set to a different process by naming a different
design kit as the source for technology files. If it is not defined at the STARTUP level, it can be defined at the USER
($HOME/hpeesof/config/design_kit.cfg) or SITE ($HPEESOF_DIR/custom/config/design_kit.cfg) level. In this case,
the value at the USER level will take precedence if defined.

DESIGN_KIT_TECHNOLOGY_NAME=<kit name>

DESIGN_KIT_CIRCUIT_TEMPLATE_PATH

This variable is used to extend the search path for the circuit schematic templates. If a design kit contains schematic
templates, this variable is set to <design_kit_path>/circuit/templates in $HOME/hpeesof/config/de_sim.cfg when
the design kit is enabled. This variable is referenced by CIRCUIT_TEMPLATE_PATH in de_sim.cfg.
DESIGN_KIT_CIRCUIT_TEMPLATE_PATH = <design_kit_path>/circuit/templates

DESIGN_KIT_HPTOLEMY_TEMPLATE_PATH

This variable is used to extend the search path for the adsptolemy schematic templates. If a design kit contains
adsptolemy schematic templates, this variable is set to <design_kit_path>/adsptolemy/templates in
$HOME/hpeesof/config/hptolemy.cfg when the design kit is enabled. This variable is referenced by
HPTOLEMY_TEMPLATE_PATH in hptolemy.cfg.

DESIGN_KIT_HPTOLEMY_TEMPLATE_PATH = <design_kit_path>/adsptolemy/templates

DESIGN_KIT_BROWSER_PATH

This variable is used to extend the search path for the library browser. The common design kit software
automatically appends "<design_kit_path>/circuit/records" to this path whenever a design kit is loaded. All the
control files and the .idf files in these directories are read by the library browser to create the Analog/RF related
libraries/sub-libraries. The library browser is a separate executable program, which is closed and restarted to pick
up the new path. This variable is referenced by HPANALOGRF_BROWSER_PATH in
$HPEESOF_DIR/config/hpeesofbrowser.cfg.

DESIGN_KIT_BROWSER_PATH = <design_kit_path>/circuit/records

DESIGN_KIT_TEMPLATE_BROWSER_PATH

This variable is used to extend the search path for the template browser. The common design kit software
automatically appends "<design_kit_name>|<design_kit_path>/circuit/templates" to this path whenever a design
kit is loaded. Each entry is in the form of <name>|<path> where <name> is the top level node displayed in the
browser and <path> is the path to the directory containing the templates. The template browser is a separate
executable program, which is closed and restarted to pick up the new path. This variable is referenced by
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HP_TEMPLATE_BROWSER_PATH in $HPEESOF_DIR/config/hpeesofbrowser.cfg.
DESIGN_KIT_TEMPLATE_BROWSER_PATH = <design_kit_name> | <design_kit_path>/circuit/templates

DESIGN_KIT_MODEL_PATH

This variable is used by the simulator to locate user-compiled models saved as dynamically linked libraries. These
are also known as shared libraries. The file extensions are .dll, .sl or .so depending on the platform. When a design
kit with a user-compiled model is enabled, the variable DESIGN_KIT_MODEL_PATH is set to
<design_kit_path>/bin/$ARCH, where $ARCH is determined by running $HPEESOF_DIR/bin/hpeesofarch.
DESIGN_KIT_MODEL_PATH is set in hpeesofsim.cfg in the project directory and is referenced by the variable
EESOF_MODEL_PATH.

DESIGN_KIT_MODEL_PATH = <design_kit_path>/bin/$ARCH

DESIGN_KIT_SIM_FILE_PATH

This variable is used by the simulator to locate data files listed on data file components such as SnP and MDIF
components. When a design kit with files in the circuit/data directory is enabled, the variable
DESIGN_KIT_SIM_FILE_PATH is set to <design_kit_path>/circuit/data. DESIGN_KIT_SIM_FILE_PATH is set in
hpeesofsim.cfg in the project directory and is referenced by the variable USER_SIM_FILE_PATH.
DESIGN_KIT_SIM_FILE_PATH = <design_kit_path>/circuit/data

DESIGN_KIT_NO_MENU (Obsolete)

Obsolete variable used by design kit code prior to ADS 2001. Design kit menus are now available full-time for all
users.

DESIGN_KIT_NO_MENU=TRUE

DESIGN_KIT_LOCAL_OVERRIDE (Obsolete)

Obsolete variable used by design kit code prior to ADS 2001 to suppress reading of the design kit configuration file
ads.lib from system-wide location. This functionality is now provided in a more flexible manner from the design kit
software and the configuration variable DESIGN_KIT_LEVELS_ENABLED.

DESIGN_KIT_LOCAL_OVERRIDE=FALSE

Accessing Both Old and New Design Kit Menus Simultaneously

In an Add-on release to ADS 2001, new design kit software was provided. The old functionality was retained where
needed to support existing design kits, but completely new menus are provided and turned on automatically without
user intervention.

With the new configuration variables, the old design kit menu in the ADS Main window is no longer readily accessible.
All design kit related activities should be performed through the new menus. The only reason to access the old menu
is for other utilities that were historically on the same menu. If access to the old menu is required, the following steps
should be taken:

1. Remove or comment out general design kit configuration variables (listed in this chapter) from any user
configurable location. These will interfere with the new software. If a design kit configuration variable is not
discussed in this chapter but is in your system configuration, perhaps it applies to a specific design kit. These can
remain as they are.

2. After removing old variables, restart ADS and verify that only the new design kit menu is visible. After this has
been verified, close ADS. [need a link to a screen dump so user knows what new menu looks like]

3. To gain access to the old software without disabling the new software, perform the following steps:
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a. Copy $HPEESOF_DIR/config/design_kit_old.cfg.unix
or
$HPEESOF_DIR/config/design_kit_old.cfg.win32
to
$HOME/hpeesof/config/design_kit_old.cfg
b. Add the following line to $HOME/hpeesof/config/de_sim.cfg
+ design_kit_old.cfg
c. Follow the directions in the design_kit_old.cfg file or read the information below and modify
design_kit_old.cfg as needed.

Remember that the value of a variable in $HOME/hpeesof/config will take precedence over one set in
$HPEESOF_DIR/custom/config or $HPEESOF_DIR/config (see Configuration Files). Use the Configuration Explorer from
the options menu in the ADS Main window to check for conflicts. Other tools may have set these variables to different
values. Resetting them here may disable other tools. This can be fixed by combining all needed values together,
separated by a colon (:).

Example:

USER_MENU_FUNCTION_LIST=app_add_user_menus:app_add_design_kit_menus

 Note

To enable better comparisons within the Configuration Explorer, set CONFIG_EXPLORER_CMP_VARS in
de_sim.cfg, but beware that this makes the Explorer run very slow on networked systems. It works best on a
stand-alone PC installation.

To make the old design kit menu visible in the main ADS window, change this value to FALSE and restart ADS. You
may need to iconize and restore the window once if the menu pick isn't visible immediately.

DESIGN_KIT_NO_MENU=TRUE

These reset the USER_AEL and LOCAL_AEL path to load the software. Definitely check for conflicts with these AEL
variables.

DESIGN_KIT_OLD_DIRECTORY={$HPEESOF_DIR}/design_Kkit

USER_AEL={%DESIGN_KIT_OLD_DIRECTORY}/design_kit_startup

LOCAL_AEL={%DESIGN_KIT_OLD_DIRECTORY}/design_kit_project_attach
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Uncomment this variable to turn on the old design kit menu in schematic or layout windows.

USER_MENU_FUNCTION_LIST=app_add_design_kit_menus

This is an obsolete variable that formerly controlled the scope of ads.lib files. For information on using the new
method of controlling the scope of the ads.lib files, refer to DESIGN_KIT_LEVELS under Current Configuration
Variables.

DESIGN_KIT_LOCAL_OVERRIDE=TRUE

Viewing Configuration Files and Variables

A useful tool for viewing configuration files and variables within Advanced Design System is the ADS Configuration
Explorer.

To launch the Configuration Explorer:

From the ADS Main window, choose Tools > Configuration Explorer. The ADS Configuration Explorer dialog box
appears.

For more information on the ADS Configuration Explorer, see Viewing Details of the Current Configuration.

For more information on configuration files and configuration variables in ADS, see Customizing the ADS Environment
and Using AEL with Component Libraries.

Disabling the Design Kit Software

The new ADS design kit software is designed to be 100% compatible with the old design kit software as it was shipped
from the factory. However, there are some extreme cases where an old design kit created outside of the factory may
not operate with the new software loaded. This is apparently due to the fact that the old factory software was modified
for a customer or by a customer, without making the names of the AEL functions unique. Since all AEL functions are
global in scope, any custom AEL code has the potential to overwrite an existing AEL function, if the custom code does
not have a unique prefix on all functions and global variables.
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Any design kits with the problem described above will also not be able to co-exist with other design kits which follow
the design kit standard structure and use the standard method to enable the design kit. These design kits should be
upgraded to follow the standard structure and use the standard software. Until they are upgraded, the following steps
can be taken to disable the new design kit software. This can be done at the user or system level.

1. Copy $HPEESOF_DIR/config/design_kit.cfg to $HPEESOF_DIR/custom/config or $HOME/hpeesof/config.
2. Edit design_kit.cfg file as follows to undefine the variables that load the design kit AEL files.
DESI GN_KI T_Ul _AEL=
DESI GN_KI T_STARTUP_AEL=
DESI GN_KI T_PROJECT_AEL=
DESI GN_KI T_PROJECT_OPEN_AEL=
3. Add +design_kit anywhere in the de_sim.cfg file which resides in the same directory where you edited
design_kit.cfg. If the de_sim.cfg file doesn't exist, create a new file.
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